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HX3.6 Manager   

The Manager for HX3.6 systems is a Windows application. Installation is not required. Just unzip 

the file hx36_manager_xxxx.zip into a folder on your local hard disk and launch the app from the 

update directory. How to connect your HX3 device to the HX3 Manager is described in the 

following chapter Connecting. 

The HX3 Manager can also be used with MacOS, see chapter HX3 Manager on a Mac. 

The HX3 Manager supports the use of your HX3 device with 

a variety of functions:   

The Panel contains switches and drawbars for your HX3 

device. In the panel window, you can adjust sounds and 

effects, as well as create, name, and save presets. When 

the panel is open, you can recall presets live using the 

function keys on your PC keyboard. 

The Preset Mover makes it easy to manage presets. You 

can use it to try out, move, and rename presets. Also use 

the Preset Mover to transfer presets from a file to the HX3 

device or to save presets to a file.  

With the Editor, you can set up the HX3 for all conceivable 

hardware configurations, access all available parameters, 

and fine-tune sounds and effects. 

With the CC Set Editor you can edit the MIDI CC Sets of 

the HX3, create new CC Sets or load them as a file from 

your PC. This allows you to make the best use of your 

keyboard controller to control your HX3 Expander, even if 

none of the included CC sets fit right away. 

The Updater updates the operating software of your HX3 

device entirely in an automatic process or individual 

selected components. Use the Updater also to activate an 

Extended License or to change the user name.   

In the start window of the HX3.6 Manager, click the button of the component you want to use. 

The application for old HX3 versions HX3.4 Remote as well as the HX3.5 Manager are not 

suitable for HX3.6. Vice versa the HX3.6 Manager cannot handle older hardware versions.  

  

http://updates.keyboardpartner.de/Files/HX3.6%20Manager%20Current%20Firmware/hx36_manager_6017.zip
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Connecting 

HX3 Manager can connect to the HX3 mainboard through several channels:  

 Preferably through USB using a cable to the B-type USB jack of the HX3 device, updates can 

be made through USB only, 

 through a bi-directional MIDI connection (IN/OUT) using a third-party USB MIDI adaptor, 

 through our FTDI serial adaptor cable FT232R-5V (available at our shop). Attach USB-to-

serial adaptor cable FT232R-5V to the HX3 6-pin header PL22 FTDI, black wire (BK) facing to 

black header PL18 SD, 

 through any FTDI device with FT232 interface chip like the one on our discontinued HX3 

Extension Board mk4. Connect the USB cable to the B-type USB jack of the HX3 Extension 

Board mk4. 

When using the USB jack, no cable must be connected to the secondary (left) MIDI input 

DIN jack. During an update MIDI DIN cables must be removed. 

In the start window of the HX3 Manager, click 

Connect.  

USB connection: Select Connect by USB 

MIDI. The HX3 device appears in the Select 

HX3 Device window as "HX3 Sound Engine" 

or similar. These entries are selected by 

default, and the connection is made via MIDI 

over USB. Select "USB Midi Cable" when 

connecting via USB MIDI interface. 

FTDI connection: Select Connect by FTDI 

Serial. Select "FT232R", "TTL232R" or similar in the device lists. Windows will automatically install 

the FTDI driver the first time you use it. For older Windows versions, the driver may need to be 

installed manually. You will find instructions for this in the README file in the update directory. 

Close the Input/Output Devices window by clicking on OK. When the connection is established, a 

green highlighted display appears at the top of the startup window and a log window opens 

showing the "Board Info" with the version numbers of the operating software components.  

If no MIDI connection is established with Connect, open analog inputs are a possible reason. The 

inputs are floating and create a confused data stream that interferes with communication. In this 

case, activate the Disable Analog Inputs on Connect checkbox. If the connection now works, 

correct the settings as described in the Assigning Controls section. Re-enable the analog inputs if 

needed by setting parameter 1503 in the System Inits to match your configuration. Especially after 

changes to the configuration of your HX3.6 device, also pay attention to the Update Checklist. 
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Tab/Drawbar Panel   

With the Tab/Drawbar Panel, the HX3 device can be operated using virtual controls. You can 

select organ and rotary models, set sounds and effects, and create and name presets. When the 

panel window is open, you can access presets live using the function keys on your PC keyboard. 

The green buttons correspond to the buttons of a classic organ. Some functions are only available 

if an Extended License is installed. With the Standard License only the B3 models and M3/M100 

of the Organ pull-down menu can be used effectively, with the Extended License also H100 and 

the various Transistor models. 

If the HX3 device is connected through MIDI or MIDI over USB, you may play the sounds for trying 

out by touching the virtual keyboard with the mouse pointer..  

Click the Upper, Lower, Pedal or Volumes tabs on the right to access the respective controls: 

Drawbars, switches to activate ADSR/Percussion (with Extended License only), the GM Layer and 

Volume controls. The Upper, Lower, and Pedal tabs allow you to save and recall voice presets 

that contain only the organ's drawbar settings. You can also add a GM Synth Voice Layer to the 

organ sound, or play it without an organ sound (set all drawbars to 0). The GM program numbers 

comply with the General MIDI standard. 

Click the Presets tab to set which parameters are saved and recalled in Overall Presets, or to save 

or load backups of presets. See Presets Panel section. 

By the way: Alternatively, the HX3.6 device system can be controlled with a tablet or smartphone, 

see User Manual HX35 TouchOSC, but wireless not simultaneously with the HX3 Manager. 

  

http://keyboardpartner.remotewebaccess.com/Files/Manuals%20%28Anleitungen%29/UserManual_HX3_TouchOSC.pdf
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HX3 Specials with Extended License 

Depending on the set Organ Model, the EG Mode Envelope drawbars and the lower row of 

drawbars are activated. The latter change their function, as do the checkboxes above them, with 

the set Organ Model. 

Perc ON/Soft/Fast also work in H100 mode (H100 is ON). Percussion sounds on the harmonics 

activated with H100 Percussion checkboxes on the right (upper) when Perc ON is ON. 

2nd Voice will disable the percussion decay circuit, so the percussion part of these harmonics will 

have a steady tone, bypassing vibrato and phasing rotor. This allows some nice chorus effects by 

routing some drawbars to effects, some not. 

Harp Sust enables a decay/sustain effect on 4‘ harmonic. 

In Electronic Gating mode (EG Mode), a soft-switching envelope generator is used instead of the 

B3-type "mechanical" key contacts. The ADSR parameters are controlled by the EG Mode 

Envelope drawbars on the right.  

With EG Perc activated, the ADSR circuit forms a percussive sound. The percussive part is 

adjusted with the Poly Perc Levels drawbars, which are now active. The decay time is set with the 

Decay drawbar of the EG Mode Envelope group 

If Ena Time is activated, the attack/decay/release times can be set to different lengths with the 

now activated ADSR Time Modifiers drawbars. This makes it possible to mimic the different 

response of long and short organ pipes. 

With Ena Dry activated, the checkboxes on the right in all EG modes for the upper manual take 

over the function Drawbar to Dry: The harmonics marked thereby sound "dry", they bypass Vibrato 

and Phasing Rotor, which can be used to achieve nice chorus effects. 

If PercON is activated with EG Mode or EG Time, the Mono Percussion checkboxes can be used 

to add H100-like percussion to individual harmonics. 

The drawbar HDcy control (Harmonic Decay) algorithmically shortens/extends the decay/release 

times differently for all harmonics. This creates effects like from a Fourier synthesizer, since HX3 

has a separate ADSR/VCA envelope generator for each foot position and each note on each 

manual. 

The lower manual does not distinguish between the different EG modes. The checkboxes take 

over the EG ADSR Enables function when an EG mode is active. Activating a checkbox switches 

the associated lower manual harmonic to ADSR mode. Otherwise, only a sound without keyclick is 

heard. 

The Extended License provides a second GM Synth Layer that can be detuned against the first to 

create a richer sound. Both layers can be harmonically transposed with respect to the drawbar 

base note. 
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Presets on PC function keys 

By hitting the Esc key or one of the function keys 1...12 you may select the live preset 0 or preset 

1...12 quickly on the PC keyboard, if the Panel is connected. To select voices quickly, choose 

upper manual, lower manual, or pedal in the drop down menu "F1..F12 Key Assign" or by hitting 

one of the keys U, l, or P, respectively. Push C or the spacebar to switch back to quick common 

preset selection.  

Saving Presets to the HX3 device 

Adjust your preset to your needs with upper, lower, pedal, volumes and common controls. Edit the 

preset name as desired and choose a preset destination number in the dropdown menu. Then 

click on the Store to # button. An existing preset at this position will be overwritten. Preset names 

can include up to 15 characters, but not umlauts. Drawbar presets (voices) cannot be named. You 

save them with the controls at the top of the tab for the respective manual. 

Presets Panel  

Click on the Presets tab to 

open the Presets panel. On 

the Presets panel you can 

determine, which items are 

recalled with your presets.  

Items that checked will be 

stored individually with single 

presets. Items that are not 

checked will be stored in 

preset #0 as default values 

and thus be valid for all 

presets. 

 

 

Preset Backup and Restore 

Use the respective buttons to backup or restore presets or voices. If you do not use all 99 presets, 

you may speed up the backup procedure by limiting the number of presets that are written to the 

backup file on the Presets Panel. Presets can also be renamed, saved and loaded using the 

Preset Mover. 
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Preset Mover 

With the Preset Mover you can easily manage your presets. You can try out, move, and rename 

presets. You can transfer presets from a file to the HX3 device or save them to a file. 

The left column corresponds to the connected device, the right column to a preset file.  

Click Get Presets at the bottom left to load the number of presets set next to the button from the 

connected HX3 device to the left column. Click Upload to transfer all presets from the left column 

to the device. Presets present in the device at the same positions will be overwritten.  

Click Load File at the bottom right to load a preset file into the right column. Click Save File to save 

all presets from the right column to a file. If you select an existing file, its contents will be 

overwritten.  
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To try out a preset from either list, select it and click the Try Out button. The preset will then be 

activated on the HX3 device, but will not overwrite any existing preset. At the same time, the name 

and settings are displayed in the panel window and can of course be changed here if desired. 

Please note: If you use Store to # in the panel, the preset will be stored in the HX3 device in the 

place set in the drop-down menu and may overwrite an existing preset. 

Click Insert to insert the preset currently selected on the HX3 device before the preset currently 

selected in the Preset Mover. Click Replace to overwrite the currently selected preset. Insert and 

Replace work in both columns. 

If you double-click on the name of the preset, you can change it. Click on another line to finish 

editing. Preset names can contain up to 15 characters, but no umlauts. 

You can move presets individually or in as a block between the two columns. You can also move 

presets within a column and thus re-sort them. To select a block, hold down the Shift key. Hold 

down the left mouse button and drag the preset or block to the desired position. Drag to the Trash 

or click on the Trash Icon to delete the preset or block. 

If you make changes in the Preset Mover in the left column, they will not be transferred to 

the HX3 device and saved permanently until you click the Upload button. Changes made in 

the right column are not saved to a preset file until you click Save File. 

 

The two columns in the Preset Mover can hold up to 200 entries each. However, Upload will only 

transfer the first 99 from the left column to the HX3 device. The rest are lost when the program is 

terminated. The right column, on the other hand, is saved in full to the preset file with Save File. 

Please be careful not to exceed the number 200, otherwise existing entries will be overwritten.  
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HX3 Editor 

The Editor is a powerful tool for setting up the HX3. By means of the Editor you may set up the 

HX3 for any possible hardware configuration. You can access all available parameters and adjust 

sounds and effects. 

At the same time, HX3 Editor is KeyboardPartner’s production tool; it does enable you as well to 

adjust your HX3 in a way that renders it completely useless for your configuration. Please use the 

Editor with due diligence; do not adjust parameters without knowing what they mean. 

On the right you see several buttons. The HX3 parameters are organized in groups. To find a 

particular parameter group, click on the corresponding button. The group will move to the top of 

the table, and will be marked as active by green parameter numbers. 

When you change values, they take effect immediately but are not stored. Click Store Defaults to 

permanently transfer all values from the table to the HX3 device.  
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File Menu  

You can save all parameter values to a file using the Save Table 

function in the File menu and load them from a file using Load 

Table or Group.  

Use this function to create a backup of the parameter values 

before you change settings so that you can revert to the old 

values if necessary.  

With Save Group you can save the values of a parameter group. When you load this file with Load 

Table or Group, the values are automatically placed in the table. 

Edit Menu  

In the Edit menu, you can use the Copy function to copy the values of 

a parameter group to the clipboard. With the Paste function you can 

paste the values from the clipboard into the currently activated 

parameter group. This function should be used with caution. The 

editor does not check whether the copied values make sense.  

Window Menu  

From the Window menu, just as from the Start window, you can 

call the Panel, Preset Mover, CC Set Editor and Updater 

components, optionally using keyboard shortcuts when the Editor 

window is open.  

In the Log Window the communication is logged.  

Action Menu  

Get All Values (Refresh) and Get Group Values can be used to 

load parameter values from the device into the table. Normally this 

is not necessary because the values are already transferred at 

Connect. With Store All Values parameter values are transferred to 

the HX3 device for permanent storage. The Get & Save functions 

are used during initial programming and are not relevant for the 

user. ReInit Board must be executed after updating the DSP or the 

Scan Driver.  

Help Menu  

Go to Entry leads directly to a selected parameter group, similar to the buttons on the right side of 

the editor window; however, the list contains more groups. Find Parameter Number ... takes you 

quickly to a specific parameter whose number is known. 
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Overview of the parameter groups 

In this overview, parameter groups that are only relevant in connection with an Extended License 

or for OEM applications are set in italics. Parameter groups with factory settings that should not be 

changed are shown in blue font. The parameter numbers (#....) are assigned consecutively only 

within the groups. 

Analog controls  

#1000 Upper Drawbars, #1048 Upper ADSR, #1224 Upper GM Synth, #1096 Upper Electronic 

Gating Percussion Drawbars: displayed values changeable in the editor. 

#1016 Lower Drawbars, #1056 Lower ADSR, #1232 Lower GM Synth: displayed values 

changeable in the editor. 

#1032 Pedal Drawbars, #1072 Pedal 4 Drawbars AutoMix/H100, #1064 Pedal ADSR, #1240 

Pedal GM Synth: displayed values changeable in the editor.  

#1080 Volumes and Trim Pots, #1091 RealOrgan Volumes: displayed values changeable in the 

editor. 

#1112 3-Band-Equalizer: displayed values changeable in the editor. 

#1124 Potentiometer Mid Positions: allow presetting of the desired middle value for potentiometers 

with center detent. 

Digital controls  

#1128 Percussion/Vibrato/Rotary  Buttons/Switches", #1136 Insert/Effect Buttons/Switches: 

displayed values changeable in the editor. 

#1144 Phasing Rotor Control Buttons/Switches, #1152 Gating/Contact Modes, #1172 Special 

Functions 1, 2, #1160 Upper/Lower ADSR Enable: displayed values changeable in the editor.  

#1264 Rotary Knobs/Switches: displayed values changeable in the editor. 

#1268 Presets/Voices: displayed values changeable in the editor. 

Preferences 

#1272 Busbar Levels, Hammond (Default) 

#1353 Keyboard Settings 

#1368 MIDI Settings  

#1384 Organ Setup (Current Generator)  

#1480 Percussion Setup  

#1448 Rotary Control, #2104 Rotary Simulation Inits, Rotary Simulation LFO Phase Inits  

#1400 Reverb Settings, #2000 Reverb DSP Setup  

#1498 GM/Piano/H100 Setup  
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#1320 Scanner Vibrato Setup (active Generator): Momentary values, depending on the selected 

organ model, are taken from the following setup data.   

#2200 ScannerVib Program Setup B3 default, B3 old, M3/M100, H100, LSI Sine, LSI Square, 

Conn SNG, Combo 

#1336 Phasing Rotor Setup (active PHR Program): Momentary values, are taken from the 

following setup data, depending on the selected PHR setting. 

#2500 PHR Program 0 ... 7 Setup  

#1496 Board Inits (System Inits) 

#1288 Current Busbar Note Offsets: Momentary values, nothing to adjust. 

#2700 BB Note Offsets all Generators, H100, LSI Sine, LSI Square, Single Note, Combo 

#1416 Current Mixture Levels: Momentary values, are taken from the following setup data, 

depending on the setting. 

#2800 Mixt Lvl Setup for Drawbar 10, 11, 12, in each case for H100, LSI Sine, LSI Square, Single 

Note, Combo 

#3000 Pedal Drawbar Factors 16, 16H, 8’, 8H 

#3524 External Key Scanner Configuration (OEM product, nothing to adjust) 

#1464 Advanced Upper Routing Bits (Perc/ADSR Modify) 

Function assignment for controls 

#5000 Analog Input Assignment/Remap, Analog MPX Input Assignment/Remap 

#5100 Button/Switch Input Assigns, Ext Panel 0, Ext Panel 1, onboard, Ext Panel 3, Ext Panel 4, 

Ext Panel 5 

#5200 Button or Switch Select, ExtPanel 0, ExtPanel 1, onboard, ExtPanel 3, ExtPanel 4, 

ExtPanel 5 

#5300 XB2 Button Input Assigns/Remaps  

Parameters on the menu panel 

#6000 Menu Enables Part 1, Part 2, Part 3 
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Parameter editing 

In the column Value click on the 

parameter value you want to 

edit.  

A help text for the selected 

parameter appears on the right 

at the bottom of the main 

window. Depending on the type, 

for many parameters, when you 

click on the value, a variable 

scroll bar, an ON/OFF switch or 

a drop-down list appears.   

Please do not change values you don't fully understand. In particular, the System Inits, 

ScanVib and Rotary Setup group are delicate to changes, which may lead to unwanted 

results.  

Normally all parameter values are transferred from the HX3 device on Connect and can be read in 

the table. In rare cases it may be necessary to retrieve the values. This is done with the Get Group 

Values or Get All Values entry in the Actions menu.  

Important: First create a backup of the entire parameter table using the Save Table function in 

the File menu. The saved ini file contains all parameter numbers and values in plain text. You can 

open the file and read values to undo individual changes. Use Load Table or Group to load the 

backup file back into the editor. Then select Store All Values in Action menu to transfer the data to 

the HX3 device. 

Changes to parameter values are always executed immediately, but they are not retained unless 

the parameter table is saved. Store Defaults stores all values of table in the HX3 device. The 

storage location depends on the parameter type and is indicated by a color coding of the 

parameter values (see legend in the lower right corner of the main editor window).  

All black and turquoise colored parameter values are stored as Common Preset.  

Red parameter values are stored as the power-on default value; they are common to all Voices 

and Presets. These settings can be lost during a firmware update in case of major version jumps.  

Pink values (System Inits) are also saved as switch-on default values for all Voices and Presets. 

These parameter values remain untouched even with major firmware updates. Check these values 

carefully after changing your hardware configuration. Also check the values the first time you use a 

brand new motherboard that is configured as a MIDI Expander at the factory.  

Values shown in grey should not be changed (read only).  
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Editing Organ Models  

HX3.6 provides four organ models, with Extended License 16 organ models. All settings are 

editable. Click on the Organ Models tab in the editor to edit the organ models. Select the model 

whose settings you want to change from the pull-down menu. In the parameter list, the associated 

settings are highlighted. Click Refresh to update the values. 

Use the buttons to navigate to the associated parameter groups. Click Store to Organ Model to 

permanently save changed settings. 

Click the Save as File button to save all settings to a file. If you want to undo changes, you can 

transfer the saved settings back to the device using the Update via USB or FTDI cable function 

from the Updater's Update menu. 
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Editing Rotary Models  

HX3.6 provides four rotary models, with Extended License 16 rotary models. All settings are 

editable. Click on the Organ Models tab in the editor to edit the organ models. Select the model 

whose settings you want to change from the pull-down menu. In the parameter list, the associated 

settings are highlighted. Click Refresh to update the values. 

Use the buttons to navigate to the associated parameter groups. Click Store to Organ Model to 

permanently save changed settings. 

Click the Save as File button to save all settings to a file. If you want to undo changes, you can 

transfer the saved settings back to the device using the Update via USB or FTDI cable function 

from the Updater's Update menu.  

      



HX3.6 Manager    17 

Setting up the Hardware Configuration 

After changing the 

configuration to a 

different device type 

(e.g. from expander to 

drawbar organ),  

check the System 

Inits parameters with 

the Editor. These 

values are persistent 

even when firmware is 

updated. 

Normally the values of 

this parameter group 

are set automatically 

by the "config_xxx.ini" 

file matching your 

device. 

Factory programming of parameter 1503 ADC Configuration is "Swell only" for MIDI expander 

use, so set the configuration according to your needs.  

Also, the “MIDI Input” scan driver is installed. If you are using FatarScan2 or Scan16/Scan61, 

install the appropriate scan driver “scanxxx.dat” contained in the Editor directory. If "scanfatr.dat" 

is installed, FatarScan2 must be connected, otherwise the communication with the HX3.6 

Manager does not work anymore. 

On custom installations, also check Analog Remaps and Switch Remaps (see section Assigning 

Controls) as the Editor will install default values here.  

Select your desired configuration settings in parameter 1501 and  1502. Check if the setting of 

parameter 1497 "Vibrato Knob Mode" corresponds to your configuration. 

With parameter 1498 you can define which settings should be stored and recalled with the 

Common Presets of the HX3. You can set the same on the preset page of the panel. 
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System Inits 

Depending on firmware version, parameters shown in Editor may differ from picture. 

1496 2ndDB Select Voice Number. Selecting this voice # on a manual (menu or 

Preset16/Preset12-2 connected to inverted keys) will turn on second drawbar set 

1497 Vibrato Knob Mode. 0 = Rotary Switch PL24, 1 = 3 toggle buttons, 2 = 4 radio buttons. 

1498 Common Preset Restore Mask. Determines, as does the Presets Panel, which params 

are saved to CommonPresets (see help text in editor window). 

1501, 1502 Various Config Bits (see help text in editor window). 

1503 ADC Configuration (0=off/module mode, 1 = swell pedal only, 2 = 0 to 24 internal inputs 

with DB9-MPX drawbar switching plus 0 to 64 external DBX/PTX inputs, 3 = 0 to 24 internal inputs 

plus 0 to 64 external DBX/PTX inputs with DBX drawbar switching. 

1504, 1505  1st DB Select Voice Number/ 2nd DB Select Voice Number. Selecting this voice # on 

a manual (menu or preset16/preset12-2 associated with inverted keys) turns on the first or second 

drawbar set, respectively. 

1506 Pedal Drawbar Configuration (0 = 2 Drawbars, 1 = 4 DBs, 2 = 12 DBs; if 0 or 1, the higher 

virtual pedal drawbars will be auto-adjusted according to setting. 

1507 ADC Scaling for analog Drawbar Input control voltages (100 = 100%, more for limited 

potentiometer voltage range, eg. in MAG organs set to 120). 

1509 HX3 Device Type (see help text in editor window). 

1510, 1511 Internal use, do not change. 

Checking the controls 

With all analog inputs enabled (parameter 1503=2), check if changes on drawbars are to be seen 

on Upper DB respectively changes on all other analog input groups are to be seen in the 

parameter table. Non-working analog inputs may have been remapped wrongly or to "not 

assigned". See Assigning analog inputs. 

If a parameter value changes randomly, this indicates a “floating” analog input. This should be 

avoided as it leads to unwanted sound changes. Connect a control or disable floating analog 

inputs (value 254 in the Analog Remap section, see Assigning analog inputs). 

Use the Input Monitor to find out which input a control element is connected to and quickly locate 

its position in the assignment. See section Input Monitor. 

The value display for the controls is updated automatically as the HX3 device sends all changes to 

the editor, but only when the Input Monitor is not open.   
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Assigning Controls 

Each analog and switch input of the HX3 mainboard can be assigned to (almost) any function. The 

connector assignment can be found in the HX3.6 installation manual.  

The 24 internal analog inputs (PL31, PL32) can be expanded to a total of 88 inputs (24 internal, 64 

external) by DBX and PTX boards on PL27; mixed operation of the older DB9 and DB12 boards 

and the DBX and PTX boards is also possible.  

The 16 internal pushbutton/switch inputs (PL35/PL36) can be extended to a maximum of 64 switch 

inputs via up to 3 Preset16 or Extend16 boards jumpered as external panels. These are 

connected in series to PL26 via a I2C bus system. 

With the Input Monitor you can very quickly and easily find out to which input a control element is 

connected and jump to its position in the assignment table with a mouse click. See section Input 

Monitor. 

Assigning analog inputs 

Two groups are available for assigning the analog inputs: For the internal inputs at PL22 and PL23 

the parameter group 5000 to 5023 (Analog Input Assignment/ Remap), for the external MPX 

inputs at PL27 the parameter group 5024 to 5087 (Analog MPX Input Assignment/Remap).  

Call up the assignment 

table with the Analog 

Remap button. For each 

analog input, you will find 

the assigned function as 

a value; a drop-down 

menu with the possible 

assignments is displayed 

in the currently active 

line. Use this to select 

the desired assignment, 

but you can also enter 

known values directly 

(double-click on the 

number).  

For example, parameter 

5009 has the function 

"Master Volume" 

assigned to input PL31 pin 10. If you have connected the TONE control to this input, set the value 

in the pull-down menu to "87 Tone Pot Equ". Make sure that you do not assign a function twice.  

Set unused inputs to "254 Not Assigned", these are skipped during the query and may then also 

be "open". The value "255 End of Assign Table" marks the end of the table group; the following 

inputs (only of this group!) are not considered. 

http://wiki.keyboardpartner.de/index.php?title=HX3.6_Installation_Manual
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If one of the table groups is not to be used at all because only internal (PL31, PL32) or only 

external (MPX PL27) inputs are used, set the first entry of the unused group to "255 End of Assign 

Table". For example, if only DBX and PTX boards are connected to MPX PL27, set parameter 

5000 to "255 End of Assign Table". If no DBX or PTX boards are used, set entry 5024 to "255 End 

of Assign Table". 

Assigning dual drawbar sets 

On our older DB9 MPX boards, switching two sets of drawbars per manual was fixed by default. 

The new DBX boards also allow two sets of drawbars per manual; to do this, System Inits 

parameter 1503 must be set to "3 DB9/12 and DBX ". 

Set analog inputs for the second drawbar sets to an entry marked "Upr2" or "Lwr2" (values from 

128). Drawbars assigned in this way become active when Drawbar Voice 1 (or the voice specified 

in System Inits parameter 1496) is called; for Voice 0, the drawbars with "Upr1" or "Lwr1" are 

active.  

By the way, old DB9/DB12 drawbar sets can also be assigned to PL31/PL32 as a second set. For 

DB9 MPX boards use operation mode 1503 = "2 DB9/12 and DB9-MPX". In this operation mode 

additional analog inputs are also polled on MPX PL20, but without considering the assignments on 

"Upr2" and "Lwr2". Operation of the old DB9 MPX boards is not possible in operation mode 1503 

= "3 DB9/12 and DBX". 

Assigning digital inputs 

To assign switch inputs 

to the desired HX3 

functions, use the Switch 

Remap table groups. For 

the 16 inputs at PL35/36 

there is the subgroup 

Switch Remap Onboard. 

With the parameters 

Input Mode or Input 

Mode Onboard you 

specify whether the 

inputs are switches 

(value ON) or 

pushbuttons (OFF).  

. 
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Input Monitor 

The editor function Input Monitor supports you in assigning analog and digital control elements to 

the HX3 functions. Click on the Input Monitor tab at the top right of the editor window. 

The Digital Input Monitor table displays the state of switches and buttons. The Analog Input 

Monitor table shows the raw values of the analog-to-digital converters (ADC) for drawbars, pots 

and other analog controls. Check the respective checkbox for the PL31 and PL32 (internal) 

connectors located on the HX3 board or the components connected via the MPX bus PL27. 

Unused analog inputs show random raw values in the Input Monitor, this does not indicate a fault. 

If you click on a table field, the corresponding position in the parameter table is called up, where 

you can assign the desired function using the pull-down menu. Use Shift+Click to go to the 

parameter of the assigned function.  

Please note: As long as the Input Monitor is open, value changes are only displayed in its tables. 

To check the function of the controls in the parameter table, first close the Input Monitor by clicking 

the tab Parameter. Do not forget to permanently save the edited assignment table with Store 

Defaults. 
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Configuring the HX3 menu 

The HX3 menu system includes quite a number of entries for tuning the HX3 sound engine. For 

live performances you may prefer a scarcer, clearer menu. No problem: Configure the menu to 

your desire by using the Editor. 

You may reduce the number of menu entries deliberately for your live configuration.  

Click on the button Menu Enables on the right. This will select the first group of menu system 

entries in the parameter table. It starts with parameter 6000 “Enable HX3 Preset” (this one should 

be left ON all the time, however). 

In the column Value click on a menu entry to witch it on or off. Menu entries switched to ON are 

255, while menu entries switched OFF are 0.  

The menu entries have been divided into three groups due to the large number. Scroll down the 

parameter table to reach the next group. It will be selected, if you click on a value in the column 

Values.  

Once you have modified the menu items as desired, select Store All Values from the Actions 

menu to transfer the changes to the HX3 device. 

If you want to make further changes, call up the respective group of menu entries again and 

repeat the steps described.  

Once the concise menu is configured as desired, you can save it to a file together with all other 

parameter values. Choose Save Table from the File menu. Save your Live Menu under a unique 

name. 

Whith an automatic update, the comprehensive default menu is installed again. To restore the 

saved menu configuration, load the file with Load Table and transfer the table to the HX3 device 

with Store All Values. 

Alternatively, you can save only the parameter groups containing the menu enables individually as 

files. To do this, use the Save Group function in the File menu. When loading the respective file 

with Load Table or Group, the parameters are automatically sorted into the correct places in the 

table. Transfer the table with Store Defaults into the HX3 device. 

  



HX3.6 Manager    23 

Updater 

You can perform a complete automatic update with the utility app DreamDFU for Windows or 

DreamDFU_kbp for MacOS as described in the operating manual for your HX3.6 device. To do 

this, set the device to DFU mode, start the app and select the update file for your device from the 

"update" directory. The updater is not needed for this.  

Under Windows you can also 

start the automatic update from 

the updater. Unfortunately, this 

does not work with Wine or 

CrossOver under MacOS, 

because these environments do 

not allow you to install a DFU 

driver. 

If necessary, check and correct 

the type of your HX3 device 

under Device Type and click 

Update!. The updater puts the 

device into DFU mode and 

transfers the appropriate DFU 

package. The connection via 

MIDI over USB will be 

disconnected. 

Exit the DFU mode after 

successful transmission by a 

restart. Afterwards you can re-

establish the connection to the HX3.6 Manager via Connect. 

In the text field on the right the "Board Info" of the connected HX3 device appears. Here you can 

read the name of the user, the serial number of the HX3 mainboard, the license keys for "Organ" 

and "Extended" as well as the version numbers of the active parts of the operating software. The 

user name can be edited, an Extended License can be added.  

The Updater is needed to install individual components of the operating software, such as a 

different scan driver after a change of configuration.  

If you only want to update your HX3 device, you can safely skip the rest of this chapter. 

On a factory programmed HX3 mainboard for organ installation, check Basic Settings first. 

In particular, the System Inits usually are default values appropriate for MIDI Expander use. 

If controls do not work as before after an update, check the configuration settings in 

Systems Inits.  
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Checklist  

 Is the Organ License OK "LED" lit (light green)? Otherwise, license number is invalid or a 

communication error occured reading it. You may need to enter the valid license number(s) 

again in the finalize window. Then click on Send new Licence or Name. 

 Is the appropiate Scan Driver installed? Should be either MIDI Input for HX3 MIDI Expander 

and HX3 Drawbar Expander FW), or FatarScan or Scan16/61 driver for other configurations. 

You may replace the Scan Driver by using the Updater (see section “Firmware Updates” 

below).  

 Are HX3 System Inits correct? HX3 will not scan buttons or analog inputs if not set correctly. 

You can change the System Inits with the editor. 

In order to configure the board for a particular device execute the appropriate file "config_xxx.ini" 

(xxx = device name) from the File menu.  

Updates via SD Card 

Update files may as well be provided on a SD or SDHC card. An appropriate SD card adaptor is 

available at our shop. Updates from SD card may as well be initiated in the Update menu or 

automatically on power-up. Attach the SD card adaptor to HX3 mainboard PL17. For details 

please see guidance  “HX3.6 SD Card Usage“.  

To use an SD card, please double-click on the appropriate batch file “make_sdcard_xxx.bat” (“xxx” 

representing your configuration) in the update directory. This will generate a sub directory 

containing all files for the SD card. Copy the files to the root directory of an empty card. 

Updates of single firmware components 

Updates for HX3 consist of several parts:  

 Controller Firmware (firmware.bin), handles user interface behaviour and MIDI CC 

 FPGA Sound Engine (fpgamain.bin), all organ sound generation 

 Scan Driver (scanXXXX.dat), handles keybed scanning or MIDI receive 

 Wavesets (wavesetX.bin), waveform definitions for different organ models 

 Taperings (taperX.dat), B3/H100 tone generator filters and manual tapering definitions 

 FIR coefficients (fir_coe.dat), coefficient file for rotary horn simulation 

 DSP firmware (dsp_ff.dfu), reverb, sound generation by GM synthesizer 

 DSP Sound Banks (gm_bank.dfu, ext_bank.dfu), audio wave table for GM synthesizer 

https://wiki.keyboardpartner.de/index.php?title=HX3.6_SD_Card_Usage
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There are also various files for preferences: default settings (defaults.dat), voice presets 

(voices.dat), common presets (presets.dat), factory parameter settings (params.dat), organ 

models (organs.dat), rotary models (speakers.dat) and MIDI CC sets (ccsetX.dat).   

Files may be used independently and may carry different time stamps; some will rarely need an 

update (wavesets, taperings, FIR coeffs). See Changelog on our update server for details which 

files are to be updated since last commit.  

To perform an update of individual components, open the DFU Updater window from the Window 

menu:   

Select the desired components from the list of available components by clicking on them in the 

Update column on the right. Set the device to DFU mode via menu. Activate the checkbox Exit BL 

when done, so that the DFU mode is automatically terminated after the transfer. Then click Send 

DFU Pack. After the installation is finished ( indicated on the menu panel), re-establish the 

connection via MIDI over USB via Connect. 

With CrossOver and Wine under MacOS this function is unfortunately not usable, because these 

environments do not allow to install the required DFU driver. Use the DreamDFU_kbp app instead. 

Some components can also be transferred to the HX3.6 device using the Update via USB or FTDI 

cable function from the Update menu. Since this transfer method is slow and less secure, it is only 

offered for smaller components. This function can also be used with CrossOver and Wine under 

MacOS. 

 
 

  

http://keyboardpartner.remotewebaccess.com/Files/index.php?dir=Current%20Firmware
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CC Set Editor 

When the CC Set Editor is called, the current CC Set is loaded. If you want to modify another 

existing CC Set, select it from the Action / Retrieve CC Set from HX3 menu. The CC Set #0 is 

limited editable because it contains proprietary encoding. 

The HX3 Function column in the Editor contains all functions that can be controlled via MIDI CCs. 

Set the MIDI channel under Channel and the CC numbers under CC according to the MIDI 

implementation table of your keyboard. As of version 5.711 NRNPs, such as Hammond uses, can 

also be set in the right column (MSB, LSB in hexadecimal notation, e.g. "$1200"). The data values 

transmitted with MIDI CC #06 are placed in the same line. 

Alternatively, you can use the learning function of the Editor: Use the control element that you 

want to assign. The last received MIDI message will then be displayed in green letters above the 

table. To check whether this MIDI message is already assigned, click the Find in Table button. To 

assign an HX3 function, select the appropriate row and click the Learn button.  

If a CC number is assigned twice, a warning message will appear. For some functions, however, it 

may be useful to use the same CC number more than once, for example, for a chorus/vibrato 

rotary switch. Here, the function is then determined more precisely based on the received data 

value. This setting option can be found under "Special Range Functions" at the bottom of the 

table. Otherwise, each CC number can only be used for one function.  
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In the section "Special Range Functions" you will also find two "Dummy Functions". If you assign 

them, the HX3 system will do nothing when it receives this MIDI data. The Dummy Functions are 

used to prevent unwanted reactions to MIDI data that some keyboards send under certain 

circumstances.  

The default value range is from 0 to 127 for drawbars and potentiometers, but also for switches (0 

= Off, 127 = On). For some functions, the value range is smaller, which you can set in the min. and 

max. columns.  

In the column Value Mode you choose how received MIDI data is interpreted: 

 Limit to min/max  Values below or above the range are limited to the respective end value. 

 Scale to min/max  If a smaller value range is set, e.g. 0 to 5, the received values 0 to 127 are 

scaled to the set range.  

 Ignore out of range  Values outside the set range are ignored. 

 Invert value  Received values are inverted, i.e. 0 becomes 127, 127 becomes 0. 

 Toggle value  The function is switched on and off alternately each time the control element is 

operated.  

 Mid Threshold  When the average value between min and max is exceeded, a function is 

switched on. 

 Inverted Threshold  When the average value between min and max is fallen short of, a function 

is switched on. 

 ON when in Range The selected function is switched on when the CC value is between min 

and max. 

 Multiply by (max/min) The received value is multiplied by the max value and divided by the min 

value. This is useful to extrapolate limited range CC values to a range needed by a particular 

HX3 parameter. Example: to multiply incoming values by 1.5, set max to 3 and min to 2. 

Press the Try Out button to transfer all settings to the HX3 device for testing. These are stored in 

RAM, but not yet permanently saved. 

When all settings have been made as desired, you can give the CC Set a name in the CC Set 

Name edit box and transfer it to the device with the menu item Actions / Send CC Set to HX3 

as…. The memory locations from 1 to 10 are available for this purpose. The location 0 "NI B4" is 

not suitable for own CC sets because of a special decoding. The assigned name will then be 

displayed on the menu panel in the "MIDI Setup" submenu.     

In the File menu, you can save a CC Set from the Editor as a .csv file and load it into the Editor 

from a .csv file. You can also save and load a CC Set in .dat format. In .dat format, the CC Set can 

be saved on an SD card and transferred from the SD card to the HX3 system. 
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Tapering Designer 

HX3 Manager contains a sixth component, which was developed only for internal use at 

KeyboardPartner and therefore is not visible in the start window at first. However, for experts with 

special desires we would like to make the Tapering Designer available. Please note: This tool 

should only be used by expert users who do not need a comprehensive user manual and know 

exactly how tone generation and tapering works in the real thing.  

Drag the bottom of the start window down with the mouse to make the Tapering button accessible. 

After launching, a window appears with the generator levels (Generator Levels tab, default values) 

of the active generator. Select the CapSet to be edited using the Select CapSet/Tapering drop-

down menu. To retrieve the values stored on the HX3 device instead of the default values, click 

the Download button.   

Attention: Older HX3 taperings (before FW #5.654) do not contain the original generator levels; 

the Tapering Designer tries to determine these from the contact levels. You may shift the levels 

with the Generator Levels Shift slider in the Defaults tab, but it is better to create a completely new 

tapering (see below). 
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The diagram displays the levels of all 91 notes. To display the level of an individual note in the 

table, right-click on the desired tonewheel note in the graphic. You can change the level in the 

table, but also by left-clicking or left-dragging (for multiple notes) in the diagram. The gray dots 

represent the idealized factory calibration for orientation purposes. 

Note that the levels for the "Complex Tonewheels" (notes 1 to 12) are outside the graphic display 

area and can only be edited in the table. Changes to the generator levels basically affect all keys 

connected via the tapering. 

After changes, transfer the values back to the HX3 device with Upload&Try; you can then check 

your settings immediately. To save the values permanently on the HX3 device, select Upload 

Single Tapering in the Actions menu.  

For archiving, you can also save the table locally on your hard disk (File menu ->Save DAT Taper 

File). The created single tapering file is saved in DAT format suitable for the HX3 Updater or SD 

card update. 

Tables in text format with 91 or 96 tonewheel levels can be imported with Import Strip mV Levels, 

e.g. CSV columns created with Excel. An example of an importable file (tg_levels_textfile.txt) can 

be found in the user directory. 

To display the levels after resistor wiring (i.e. directly at the key contacts), switch to the Contact 

Levels tab. All harmonics are initially displayed together here in different colors. Select an 

individual harmonic at the top right to display only the levels of a specific harmonic and to change 

them if necessary. This diagram always displays only 61 notes (keybed range). A change here or 

in the Contact Levels table has no effect on the original generator level. The Contact Levels are 

ultimately the values that HX3 uses for the overall tapering in the taperX.dat files. 

Create new taperings 

Select Reset to Default in the File menu and save the taperings with File->Save All DAT Taper 

Files to your updates directory (later if necessary). You can also upload the new taperings to the 

HX3 device immediately with Actions->Upload All. 

The "randomness" of the level distribution for the 1955, 1961 and Recap settings is determined by 

the sliders in the Randomizer tab; the algorithm primarily affects the LC-filtered tonewheels. The 

1972 setting represents the factory adjustment; no randomization occurs here. Note that changes 

to the sliders immediately affect all generator levels in the current column; manual changes in both 

the generator and contact level tables are thus lost. These must always be made after a slider 

setting. 

  



30    HX3.6 Manager 

HX3 Manager on a Mac 

HX3 Manager is compatible with the free Windows runtime environment Wine. Wine is available 

for MacOS 10.8 to 10.14 (not yet for Catalina at the time of publication of this guide). Here's how it 

works:  

1) Download and install XQuartz. 

2) Download "Wine Stable" and install it in default configuration (without 64-bit support). 

3) Connect your HX3.6 system to your Mac via USB and start it. 

4) Start HX36_Manager.exe by double clicking on the file icon. In the Wine dialog box that opens, 

confirm "Run directly in ...". The HX3.6 Manager app should now appear on your screen and work 

as intended.  

Alternatively, you can use the HX3.6 Manager in the Wine variant CrossOver from Codeweavers 

(also for new macOS versions). The trial version runs for 14 days free of charge. Steps: 

1. Create a new bottle by hovering to the CrossOver top menu "Bottle" and select "New Bottle". 

2. Name your bottle, select type Window 10 and create. 

3. Right click the bottle, select "open c:drive" and copy the HX35_Updates_xxxx folder into 
"program files". 

4. Click "run command" and browse for the HX36_Manager.exe and click run. 

5. One the application launch click "save command as launcher" to save an icon of the application. 

In the future you can start the HX3.6 Manager with a double-click. 

A DFU driver cannot be installed under Wine or CrossOver as things stand. Therefore, you cannot 

use the Windows version of the DFU utility. Instead, use the Mac version DreamDFU.kbp, which 

is available for download on the update server. For startup, follow the note in the attached 

README file. 

Of course you can also set up a complete Windows environment on the Mac, for example using 

Apple Boot Camp or in a virtual machine such as Parallels Desktop or VMware Fusion. 

 

  

https://www.xquartz.org/
https://dl.winehq.org/wine-builds/macosx/download.html
http://updates.keyboardpartner.de/Files/Current%20Firmware/DreamDFU_Mac.zip
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Documents library, Download repository: 

updates.keyboardpartner.de 
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